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Introduction:
Opportunity for Windows is a set of two easy to use yet powerful tools for managing people 
and information. For more information, please click on one of the following items.

About People Manager
About Info Manager
About    Insanely Great Software
Shareware Registration Information
Order Form

People Manager Help
Info Manager Help

Opportunity for Windows, People Manager, and Info Manager © 1994 by Adam Stein. All 
Rights Reserved.



Info Manager Description:
Info Manager is a powerful tool for managing your data. Your data is organized by category 
and keyword. Clicking on a category brings up a list of keywords. Clicking on a keyword 
brings up a list of associated items. You can then browse (and edit) the items immediately 
from within the same window. To edit or view the data in a pop-up window, simply click the 
right mouse button on the data.

Each piece of information is only stored once, but can be accessed from different "paths" 
allowing you to create cross-referenced data banks of information. In the example 
computer database (included in this package), you can start your search with one of 
several different categories: By Manufacturer, By Price Range, or By Processor. Clicking on 
"By Processor" yields a list of keywords---486SX, 486DX, 486DX2, and Pentium. Clicking on 
one of the keywords lists computer models built on the specified processor. Clicking on a 
specific computer displays complete information on the computer model. The exact same 
computer can be reached through the By Manufacturer or By Price Range categories as well
as a general search of all data. (You can also search data by the date it was entered---very 
handy if you remember adding important data a couple of days ago but just can't 
remember what it was.

Info Manager is comfortable with all levels of organization. Its search features make it 
perfect for random personal information files full of data from credit cards to phone 
numbers. Its category/key word approach makes it perfect for corporate information 
databases. And of course, any file can mix the two approaches, with some data floating in 
the database unattached to any key word or category, and some data completely indexed. 
You choose the level of organization that fits your needs.

Info Manager is difficult to describe in words---but once you start using it, you'll wonder how
you ever managed without it!

Click here to return to Table of Contents                          
Click here to go to Info Manager Help        



About Insanely Great Software:
Insanely Great Software was founded in 1988 by myself (Adam Stein) while I was a 
freshman in high school. (I'm currently studying entrepreneurial management at the 
Wharton School of Business at the University of Pennsylvania.) The name comes from Steve
Jobs, who often called things he really liked "insanely great." It's also our motto---and our 
standard. We aim to make your experience with us one worthy of our name: from product 
quality to technical support.

We also aim to bring you the advantages of a small company without sacrificing the 
professionalism of a large corporation. So you'll be able to talk to me personally whenever 
you'd like (try talking to the President or programmer in large companies like Microsoft or 
Lotus!), but you'll also be able to order by credit card 24 hours a day, 7 days a week, from 
our toll-free 800 order lines. (As well as fax, email, and regular mail!) And we ship within 24
hours, so that you won't have to wait for your products any longer than necessary! We'll 
even ship your order out Airborne Express if you desire. International customers can get 
express shipping as well--- usually arriving in less than a week depending on your country---
for very inexpensive rates.

If you're not a Macintosh user, you've probably never heard of us before as Opportunity for 
Windows is our first product for Microsoft Windows. To our new Windows users, I'd like to 
offer a special welcome. We're very excited to develop for the Windows platform and look 
forward to serving you in the future!

Click here to return to Table of Contents                            



Importing and Exporting Files:
Importing and exporting are a bit more complicated than opening and saving. They allow 
you to import and export to and from comma-delimited or tab-delimited text files.

To import a file, select Import... from the File Menu. People Manager will then display a 
dialog box where you can enter the specifications for the file you are importing. If it is a 
comma- delimited file, click on the comma-delimited radio button. If it is a tab-delimited 
file, click on the tab-delimited radio button.

The next step is to tell People Manager the fields that you'd like to import, in the order they
are in the file you are importing. The list box on the right side of the dialog box includes the
fields that are available to choose from. The list box on the left side (currently empty) will 
include the fields that it actually uses to import the file. To add a field to the left list box, 
select a field from the right list box and click on the Add button. You can also use the 
mouse to drag fields from the right list box to the left list box, or to change the order of 
fields in the left list box.

If the file you wish to import includes additional information that you do not want to capture
in a People Manager field, you'll need to insert a place holder. Simply add the Ignore Field 
(at the bottom of the right list box---you might have to scroll to find it) to the left list box in 
the place that it would be read from the imported file. You can also delete a field in the left 
list box by selecting it and clicking on the Delete button.

When you are finished setting up the fields, click on the Import button. It will display an 
open file dialog box from which you can select the file to be imported. (The default 
extension is .txt, but any tab-delimited or comma-delimited text file will work so feel free to
change the extension if necessary.) Once you select the file to import, click the OK button. 
People Manager will begin to import the file. Once it is finished, it will display a new People 
Manager window with the data it imported.

To export a file, select Export... from the File Menu. You can then follow all the steps 
described in the Importing section of this manual, except for the obvious difference that 
you will be exporting to a text file rather than importing from one. The process, however, is 
identical.

Click here to return to People Manager Help



Tech Support:
Technical support is available to all users of Opportunity for Windows at no charge. You may
contact our technical support staff (i.e., the author!) if you have any problems with or 
questions about Opportunity for Windows. We're also very open to suggestions for 
improvements to the program.

You can call the author direct at 908-548-5107. Faxes can be sent to 908-632-1766. On 
American Online, send email to AdamStein. On Compuserve, send email to 71140,2051. 
Internet users (and users of any service with access to the Internet) can reach the author at
AdamStein@aol.com.

Of course, you can also send mail to us at:
Adam Stein
Insanely Great Software
126 Calvert Ave. E.
Edison, NJ 08820



Beta Testing:
I'm always looking for good beta testers, and all registered users are more than welcome to
join our beta testing team.

Beta testers are an invaluable part of the development process. As a beta tester, you'll not 
only help me find bugs in my software, but also discuss new features and make suggestions
that guide the development of our products.

I currently do all my testing on America Online, a commercial online service, and the 
Internet. America Online is the most inexpensive of the commercial services, and their 
email system is particularly well-suited for beta testing. If you're not already an America 
Online user, you can get their starter software kit and 10 hours free by calling 800-227-
6364. Users (especially international users who do not have access to America Online) are 
welcome to beta test through the Internet. I do not use Compuserve for regular beta testing
due to their current cost structure.

To join our beta testing team, just send an email message to AdamStein on America Online 
(or AdamStein@aol.com on the Internet) with your name and address so that I can confirm 
that you're a registered users.



Status Bar:
People Manager displays a status bar at the bottom of its window. It displays the time, date,
record mode that you're in, and memory left. If the memory reading is low, you might want 
to save your work and possibly restart windows. (To restart windows, simply quit Windows 
and run it again.) Please see the Adding, Deleting, Editing, and Viewing Data section to 
learn more about the record mode.

Click here to return to People Manager Help



Adding, Deleting, and Editing    Key Words

To add a keyword, first click on the category that you'd like to add a key word to. Then, 
look for the edit text box underneath the Key Words: list box. Click on the box to select it, 
and type in the key word you'd like to add. Finally, click on the Add button beneath the box 
to add it to the category's    list of key words.

To delete a keyword, first click on the category that you'd like to delete a key 
word from. Then, click on the key word you want to delete. Finally, click on the Delete 
button underneath the key word edit text box to delete it.

To change a keyword, first click on the category that you'd like to change a key word in. 
Then, click on the key word you want to change. Change the key word's name in the edit 
text box underneath the Key Words: list box and click on the Change button to make your 
changes take effect. 

Please note that if a category is already selected, you do not need to select it again.

Click here to return to Info Manager Help 



Changing the Window Font
 With Info Manager, you can specify a different font for every file that you use. (The font 
information is saved inside the file so that it will retain this information between restarts.) 
To change the window font, select Select Window Font... from the Options Menu. The 
standard MS Windows font choosing dialog should appear. Choose the font and font size 
you prefer and click on the OK button.        

Click here to return to Info Manager Help    



Opening and Saving Database Files:
To open or save a file, go to the File Menu and select the respective command. The 
extension for Info Manager files is .DAB, although you can change the extension in the open
and save file dialog boxes to display other files.

Click here to return to Info Manager Help



Searching Your Data Items:
To search the entire database by text, go to the Search Menu and select the Search All
Items By Text... menu item. Type in a word to search for. Info Manager will display all items 
containing the word in either its key words, name, or item view fields.

To search by date entered, select Search All Items By Date Entered... from the Search 
Menu. Then type in the date in the format specified. Info Manager will display all items 
added on the date specified.

Click here to return to Info Manager Help



Adding, Deleting, and Editing Items
To add a keyword, first click on the category that you'd like to add a key word to. Then, look
for the edit text box underneath the Key Words: list box. Click on the box to select it, and 
type in the key word you'd like to add. Finally, click on the Add button beneath the box to 
add it to the category's    list of key words.

To delete a keyword, first click on the category that you'd like to delete a key word from. 
Then, click on the key word you want to delete. Finally, click on the Delete button 
underneath the key word edit text box to delete it.

To change a keyword, first click on the category that you'd like to change a key word in. 
Then, click on the key word you want to change. Change the key word's name in the edit 
text box underneath the Key Words: list box and click on the Change button to make your 
changes take effect. 

Please note that if a category is already selected, you do not need to select it again.

Click here to return to Info Manager Help      



Info Manager Help:
Info Manager Description

Everything you ever wanted to know about Categories, Key Words, and Items

Adding, Deleting,and Editing Categories
Adding, Deleting, and Editing Key Words
Adding, Deleting, and Editing Items
Changing the Window Font
Drag and Drop Files Feature
Opening and Saving Database Files
Searching Your Data Items

Click here to return to Table of Contents



Adding, Deleting, and Editing Categories:
To add a category, look for the edit text box underneath the Categories: list box. Click on 
the box to select it, and type in the name of the category    you'd like to add. Finally, click 
on the Add button beneath the box to add it to the Categories: list box.

To delete a category,click on the category name in the Categories: list box. Then, click on
the Delete button to remove it.

To change a category, click on the category name in the Categories: list box. Change the 
category's name in the edit text box underneath the Categories: list box and click on the 
Change button to make your changes take effect.

Click here to return to Info Manager Help      



Everything you ever wanted to know about Categories, 
Key Words, and Items
Info Manager is based on three basic object types---Categories, Key Words, and Items. Each
object type has its own list box from which you can choose individual categories, key 
words, and items.

Your data is stored in Items, while Categories and Key Words are merely used to index your 
data. It is important to understand that there is no direct link between items and categories
or key words. Neither categories nor key words "own" any items.

In fact, you could use Info Manager without ever adding a Category and Key Word. You 
could still browse through the data by clicking on the Show All Super-Category stored inside
the Category list box. (Show All is not a real category, but instead shows all key words and 
items.) You could also use the Search Menu to search your data items by word or date 
entered.

However, by using categories and objects, you can add substantial value to your data for 
anyone who wants to browse it.

Every category has its own list of key words. The key words are not exclusive as two or 
more categories can share the same key words. Keywords then point to your data items. 
They do not own your data items, but instead (when selected) search for all data items that
contain the selected keyword and display them in the items list box. Items can have 
multiple key words, so that one can reach the same data item with different key words. And
since one can reach different (or even the same) key words with different categories, one 
can reach the same data item with different categories. Every data item is cross-indexed 
and reachable through multiple pathways.

The best way to learn how to use Info Manager is to jump in and try it for yourself. Please 
consult the documentation file for a step by step tutorial on how to use Info Manager, or 
take a look at individual steps through this help file.

Click here to return to Info Manager Help



People Manager Help:
People Manager Description

Adding, Deleting, Editing and Viewing Data
Drag and Drop Files Feature
Importing and Exporting Files
Opening and Saving Files
Printing Labels and Form Letters
Show Menu
Special Cut, Copy, and Paste
Status Bar
Toolbar
Toolbar Orientation

Click here to return to Table of Contents



Drag and Drop Files Feature:
Windows 3.1 users can drag files from the File Manager into the Info Manager Window to 
open Info Manager files directly, bypassing Info Manager's Open command. Users can also 
type a file name in the command line (if run from the File Manager's Run command) to 
open a file directly.

Click here to return to Info Manager Help



Drag and Drop Files Feature:
Windows 3.1 users can drag files from the File Manager into the People Manager Window to 
open People Manager files directly, bypassing People Manager's Open command. Users can
also type a file name in the command line (if run from the File Manager's Run command) to 
open a file directly.

Click here to return to People Manager Help



Show Menu:
People Manager can only display approximately 4,000 records at one time in the list box. If 
you are working on large files, you'll need to use the Show Menu to display the records that
you want to work with. Simply go to the Show Menu and select one of the menu items to 
limit the records displayed. One special note---if you add a record that is outside the 
constraints in the Show Menu, the record will be added but not shown. You can display the 
record by going to the Show menu and selecting the appropriate menu item.

Click here to return to People Manager Help



Toolbar Orientation:
You can also change the orientation of the toolbar by selecting Horizontal Toolbar, Right 
Vertical Toolbar, or Left Vertical Toolbar from the Options Menu.    

Click here to return to People Manager Help



Toolbar:
People Manager offers a toolbar from which you can quickly select commonly used features
of the program. From left to right, the buttons in the toolbar represent the following 
features: help, open, save, cut, copy, paste, cascade windows, and tile windows.    

Click here to return to People Manager Help



Special Cut, Copy, and Paste:
People Manager offers the standard cut, copy, and paste commands to cut, copy, and paste
text as in other Windows applications. It also offers Special versions of these commands 
that allows you to cut, copy, and paste address records between different People Manager 
files.

To cut or copy address records from a file, simply select the record or records that 
you'd like to cut or copy. Then select Special Cut or Special Copy from the Edit Menu.

To paste address records you have previously cut or copied, simply select the 
People Manager window you would like to paste into and select Special Paste from the Edit 
Menu.

Click here to return to People Manager Help



Searching Your Data:
Searching by criteria in People Manager is extremely easy. Simply click on the Clear Button 
in the People Manager file that you are working with. Then, type in the criteria you'd like to 
search by in all the fields that you'd like to search for. If you wanted to find any person 
named Smith who lived in the 08820 area code, you would simply type Smith in the Last 
Name field and 08820 in the Zip Code field. Then, click on the Find Button to start the 
search. When People Manager has searched all the records in the file, it will open a new 
window with the found records.

This new window is completely independent of the original file and can be saved, printed, 
or edited just like any other window. You can also do an additional find to narrow the 
criteria. Since the new window is independent, changes made to its data will not affect the 
original file.

Please also note that the state of the check boxes will affect the Find operation. Leaving a 
check box unchecked will limit the search to records with that check box unchecked. 
Checking a check box will have the opposite effect.    



Printing Labels and Form Letters:
You can print both labels and form letters in People Manager from either the current record,
selected records (both contiguous and discontiguous), for the entire file.

If you'd like to print with several addresses (for either labels or a form letter) at 
once, you need to first select them with the mouse. Go to the list box on the left side of the
window, and click and drag the mouse to select the addresses you are interested in 
printing. If you'd like to select discontiguous addresses (i.e. addresses that are not next to 
each other in the list box), simply hold down the Control Key when clicking the mouse. (The
easiest way to select discontiguous addresses is to hold the control key down the whole 
time you're selecting records.)

If you want to print either the current record or the entire file, simply continue on 
to either the Print Labels or Print Form Letter section.

To print labels, select Print labels... from the File Menu. People Manager will then display a
dialog box with three buttons: Current Record, Selected Records, and All Records. Click on 
the appropriate button that represents what you'd like to print.

People Manager then displays the Label Setup dialog box which allows you to choose and 
define label sheet formats and the font you'd like for printing.

To create a new label sheet format, click on the New... button. Then type in the number of 
rows and columns for the label sheet. The total number of labels is thus the number of rows
multiplied by the number of columns. Finally, give the label sheet format a descriptive 
name. Click on the OK button to save the label sheet.

To select a label sheet format to print with, simply click on the name of the label sheet in 
the list box in the upper left hand corner of the Label Setup dialog box. You can later 
change or delete a label sheet format by selecting it and clicking on either the Change... or 
Delete buttons.

Next, select a font to print with by clicking on the Choose Font... button. People Manager 
will present you with the standard font selection dialog box from which you can choose the 
font to print. When you click OK, People Manager should display your choice next to the 
Font: label in the Label Setup dialog box. Now, click OK in the Label Setup dialog box. Your 
labels should begin to print. That's all there is to it!

To print form letters, you must first create a text file that contains the form letter. You 
can do this with a word processor or text editor, or do it all from within People Manager. If 
you'd like to use People Manager to create your form letter, go to the Form Letters Menu 
and select New form letter. People Manager will then display a new untitled window where 
you can type your letter. Just type as you normally would, except that the following words 
will be replaced by the fields in the records you are printing the mail merge with. (For an 
example form letter, see form.txt.)

<<First Name>>
<<Last Name>>
<<Company Name>>
<<Address1>>
<<Address2>>
<<City>>
<<State>>
<<ZipCode>>



<<Country>>
<<Phone>>
<<Fax>>
<<Email1>>
<<Email2>>
<<Num>>
<<Date>>
<<Notes>>
<<CheckBox1>>
<<CheckBox2>>

<<CheckBox1>> and <<CheckBox2>> will be replaced with either True or False 
depending on state of the respective check boxes in each record.

Once you are finished typing your form letter, save the file by selecting Save as... from the 
Form Letters Menu.

To now begin the mail merge, select Print Mail Merge... from the File Menu. People Manager 
will then display a dialog box with four buttons: Current Record, Selected Records, All 
Records, and Set Font... First, click on Set Font... to select the font that you'd like to use for 
the form letters. Then, click on one of the first three buttons that represents what you'd like
to print.

People Manager will then display an open file dialog box from which you can select the form
letter to print. Navigate through your directories until you find the form letter you'd like to 
print. Then select it and click on the OK button. Your form letter will begin to print.

If you need multiple fonts or styles in your form letter, you will need to use People Manager 
in conjunction with your word processor. You can then use People Manager's flexible export 
feature to export the records for use in your word processor. Please consult your word 
processor's manual for information on how to use its mail merge feature.

Click here to return to People Manager Help



Opening and Saving Files:
Opening and saving files is accomplished in Opportunity in Windows as in other Windows 
programs.

To open a file, select Open address book... from the File Menu. Then, navigate through 
your directories to find the correct directory and select the file that you wish to open. 
Finally, click on the OK button to open the file. (You might need to change the .wab 
extension to *.* or another extension if you saved a People Manager address book file with 
a different extension. If you're not sure how to do this, consult your Windows manuals or 
computer company for support on how to use the open file dialog box. And as with all your 
questions, please feel free to call us for help whenever you need it.)

To save the currently selected address book, select Save address book as... from the 
File Menu. Then, navigate through your directories to find the directory where you would 
like to save the file. Finally, type in a file name and click on the OK button. 

Click here to return to People Manager Help



Adding, Deleting, Editing, and Viewing Data:
The heart of People Manager, is of course, your address data. It utilizes a single window to 
handle all of these functions---allowing you to view both individual records and the entire 
list of records at the same time.

Important information on formatting of data:
Text fields can contain any characters that you wish. The number field expects a decimal 
number or integer. Characters entered in the number field are meaningless. The date field 
should be entered in the format mm/dd/yy. Acceptable dates include 9/9/93 and 09/09/93. 
You do not have to include zeros, but the month, day, and year cannot exceed two digits 
each. The order of the month, day, and year are not important. Feel free to use any format 
you prefer. For example, dd/mm/yy will work just fine. I do recommend however that you 
use a consistent method so that your date field is meaningful.

To add a record, first check to make sure that you are in "New Record Mode" by looking at
the status bar at the bottom of the People Manager window. You should see the time, the 
data, the current mode, and the amount of memory remaining. The current mode should 
say "In New Record Mode." If it says "In Change Record Mode," simply click on the Clear 
button to change to New Record Mode. (Clear doesn't actually delete a record, it just clears 
all the fields and puts you into New Record Mode. However, if you've typed a record without
adding it and click on the Clear Button, the information you typed is cleared.)

Now that the status bar says "In New Record Mode", you can begin. Simply type all 
applicable information that you'd like. Then click on the Add Button. You should now see the
name of the person you added in the list of records to the left of the window. (If you listed a
company name without a first and last name, it will show the company name instead. And 
if you did not type in either a company name, first name, or last name, the record will be 
added, but will simply show a blank in the list of records.

To delete a record, click on the item in the list of records that you'd like to delete. This 
action will show the record, thus also removing any information that you've typed in for a 
new record (or changes made to an old record.) If you have added or changed any 
information, it will give you the opportunity to save your changes. You can also delete 
multiple list records at one time by holding down the control key to select discontiguous 
selections, or by dragging the mouse to select contiguous selections.

To edit a record, click on the item in the list of records that you'd like to edit. Clicking on a
record to view has the same results as discussed in the paragraph above. Then, change the
information that you'd like to, and click on the Save Button to save your changes. (The 
Save button and the Add Button are in the same place. The button's name changes to Save
when you are in Change Record Mode to reflect the fact that it is saving changes and not 
adding a new record.)

To view a record, simply click on the item in the list of records that you'd like to see. 
That's all there is to it, although it will put you in Change Record Mode. (To go back to New 
Record Mode, simply click on the Clear Button. It may also (as described above in the 
delete a record paragraph) ask you if you want to save your changes to the last record. 

Click here to return to People Manager Help



Credits:
I'd like to thank Ian Hayes of Soft Systems Ltd. for his DndLB library and Peter Chane for the
name of Opportunity for Windows. I'd also like to thank Borland International and Software 
Interphase, Inc. respectively for Borland Pascal w/ Objects 7.0 and the Windows Help 
Magician.



Shareware Registration Information:
Opportunity for Windows is shareware---or try before you buy software---which means that 
you can freely distribute Opportunity for Windows, but that you have to pay the registration
free ($19.95 for People Manager or Info Manager, and $29.95 for both) if you use it.

After 30 days, you must either pay the registration fee, or delete all copies of Opportunity 
of Windows from your system.

Shareware is based on trust---authors rely completely on the honesty of their users. It is up 
to users like you to keep it alive. I put a lot of time and energy into Opportunity for 
Windows to make it the product it is today. I also spend a lot of time each day helping out 
users---registered and non-registered alike---by phone, email, and mail. It's hard work 
(especially as a full-time college student!), but the support from users all over the world (in 
over 25 countries) has more than made it worthwhile. I wouldn't give this up for anything in
the world--and I plan to continue full-time after I graduate from college.

Some users do not send in their fees thinking that others will send in their fees. But in 
reality, every user is kind of a barometer of everyone else. If you do not send in your fee, 
most likely, others will not send in their fees. If users do not send in their fees, shareware 
authors will stop producing quality software. We will all lose in the end if we do not support 
shareware.

When I receive your registration for People Manager, Info Manager, or the Opportunity for 
Windows Bundle, I'll send you (within 24 hours!) the most up-to-date (the version you're 
currently using may be old) registered version eliminating the opening shareware 
registration notice and the "Unregistered" window titles in People Manager and Info 
Manager. You'll also be entitled to comprehensive, unlimited FREE support from the author 
by mail, email, fax, and phone.

Pricing & Shipping Options:
You can purchase People Manager or Info Manager individually for only $19.95 each, or 
purchase the entire Opportunity for Windows package for only $29.95!

Discounts begin with orders of only 5 copies. Take 10% off for all orders of 5 copies or more.
Take 15% off for all orders of 10 copies or more. And take 20% off all orders of 20 copies or 
more. For more than 50 copies, please contact us for site license information.

Shipping and handling is $5 per order for addresses in the US, and $7.50 for international 
shipping.

We also offer overnight shipping in the U.S. via Airborne Express for an additional $10 per 
order. International express shipping is available for only an additional $15 per order.

How to Register:

We believe that perhaps the best way for us to show you our appreciation for your order is 
to make the registration process as easy as possible!

You can register by phone 24 hours a day, 7 days a week by phone (both Toll-FREE and 
international lines), fax, email, or mail. We gladly accept checks, money orders, Visa, 
MasterCard, and P.O. Orders. And since we ship within 24 hours, you won't have to wait 
long to receive the products you order.

Checks and money orders should be made payable to Insanely Great Software and drawn 



on a US Bank in $US. We will also accept cash, although we recommend that you wrap it in 
paper so that it doesn't get "lost" on the way!

Ordering by Phone:
 We're open 24 hours a day, 7 days a week for your convenience.
Call Insanely Great Software Toll-FREE at 800-368-5195.
International users should call 303-872-8651.
(These numbers are for orders only. For information, please call Adam Stein at 908-548-
5107.)

Ordering by Mail:
To order by mail, print the ORDER.TXT file and mail it to:
Adam Stein
Insanely Great Software
126 Calvert Ave. E.
Edison, NJ 08820

If the ORDER.TXT file isn't available, feel free to just include the necessary information, or 
print the order form contained in the Help File included with Opportunity for Windows.

Ordering by Fax:
We welcome your fax orders 24 hours a day, 7 days a week. Just fax your name, address, 
credit card information, and the name(s) of the product(s) you'd like to order to: 908-632-
1766. You can also fax us a copy of the ORDER.TXT file.

Ordering by Email:
We can accept email orders through America Online, Compuserve, and the Internet. Just 
send your name, address, credit card information, and the name(s) of the product(s) you'd 
like to order to:
America Online: AdamStein
Compuserve: 71140,2051
Internet: AdamStein@aol.com.
(Feel free to email us a copy of the ORDER.TXT file as well.)

Ordering by P.O. Order:
We welcome P.O. Orders by mail, fax, or email. 



Opportunity for Windows Order Form:
Qty: Description                                                                                                                                                           
Price                                          SubTotal
____ Opportunity for Windows $29.95  _______

Both People Manager and Info Manager (Our Best Value!)

____ People Manager $19.95  _______
____ Info Manager $19.95  _______

Discounts: 10% for 5 copies or more. 15% for 10 copies or more. 20% for 20 copies or 
more.

Standard shipping and handling. ($5 US, $7.50 Int'l.)  _______
US Overnight. Please add an additional $10.  _______
International Express. Please add an additional $15.  _______

                                                                                                                                                                                               
 Total:  _______

Name:_____________________________________________________________________
Company:__________________________________________________________________
Address:___________________________________________________________________
City/State/Zip:_______________________________________________________________
Country:____________________________________________________________________

Payment:
__ Check or Money order made payable to Insanely Great Software. (Must be drawn on US 
Bank.)
__ Visa __ MasterCard __ P.O. Order # ___________
Credit Card Number : _____________________    Exp. Date: ________

Comments or suggestions:
__________________________________________________________________________
__________________________________________________________________________

Thanks for your order! Your order will be shipped within 24 hours.
Please return this form with payment to:
Adam Stein
Insanely Great Software
126 Calvert Ave. E.
Edison, NJ 08820

or order by phone, fax, or email:
Phone(24 hrs/7 days!): 800-368-5195 or 303-872-8651 (Orders Only)
Fax: 908-632-1766
AOL: Adam Stein, CIS: 71140,2051,    Internet: AdamStein@aol.com



People Manager Description:
People Manager is a powerful, yet easy to use address book manager for Microsoft 
Windows. Its easy to use interface offers instant editing, adding, deleting, and viewing of 
records from a single window. More than one window can be opened at a time, and an 
innovative Special Cut, Copy, and Paste extends the clipboard metaphor to allow the user 
to cut, copy, and paste addresses from one document to another.�

Its powerful Find command searches for addresses by your criteria and inserts your found 
addresses into an independent document that can be searched or changed like any other 
document. You can print both labels and form letters, from either the current record, 
selected records (including discontiguous selections!), or the entire document. A handy 
form letter editor is also built into the program. The Import and Export commands offer 
easy and flexible methods to import and export your data.

People Manager is perfect for business or home use---whether you're keeping track of 
contacts and customers, or friends and family, there's no better way to keep in touch with 
the people that are important to you.

Click here to return to Table of Contents
Click here to go to People Manager Help        




